# Table Of Contents

1.1 Document Purpose.........................................................................................3  
1.2 Intended Audience .......................................................................................3  
1.3 Assumed Knowledge....................................................................................3  
1.4 Software Required.......................................................................................3  
1.5 What is the Asset Register........................................................................3  
1.6 What are the ‘Books’ ..................................................................................3  
1.7 Query, Update and Group Users...............................................................2  
1.8 Coding of Invoices .....................................................................................2  
1.9 Physical Inventories ....................................................................................2  

2 ASSET REGISTER SYSTEM LOGIN..................................................................3  
2.1 Getting Started............................................................................................3  

3 ASSET REGISTER SYSTEM LOGIN................................................................5  
3.1 Getting Started............................................................................................5  

4 ASSET REGISTER NAVIGATION..................................................................8  
4.1 Overview........................................................................................................8  

5 SUB-DEPARTMENT MAINTENANCE..........................................................9  
5.1 Overview........................................................................................................9  
5.2 Window Functions.......................................................................................9  
5.3 Sub Department Edit ................................................................................10  
  • 5.3.1 Overview 10  
  • 5.3.2 Page Controls 11  
  • 5.3.3 Page Fields 11  
5.4 Add New Sub-Department........................................................................11  
  • 5.4.1 Overview 11  

6 ADD A NEW ASSET.........................................................................................12  
6.1 Overview......................................................................................................12
Introduction

1.1 Document Purpose
The purpose of this document is to provide users with procedures on how to operate the Asset Register System. The overall administrative part of the Asset Register System will be operated from Director of Buildings Office while each departmental executive officer will be responsible for their department’s Asset Register.

1.2 Intended Audience
The intended audience for this document is:
• Departmental Executive Officer

1.3 Assumed Knowledge
It is assumed that the each departmental executive officer has knowledge of the Internet and basic computer functions.

1.4 Software Required
In the past it has been noted that some browsers may exhibit slightly different characteristics than that expected. Although IS Services will provide assistance to users using Internet Explorer 5.0/5.5 and Netscape 4.75 - 6.2, the recommended browsers for this system are Internet Explorer 5.0/6.0 and Netscape Navigator 6.2 and higher versions. These browsers can be installed for the IS services web site:
http://isservices.tcd.ie/help/internet/web/how.html
Please contact IS Services helpdesk if you have any difficulties accessing the system.

1.5 What is the Asset Register
The asset register is a record of all assets owned by the college (and some that are on loan or leased to college). Each asset has a certain amount of information associated with it and must be provided.

1.6 What are the ‘Books’
Insurance:
Executive Officers and the Finance Committee have dictated that the insurance risk associated with your asset register not being kept up to date is a matter for your own department. Please note that the excess on the computer policy is €5,000 and on the property policy is €50,000. It is imperative that all assets are entered in your Asset Register particularly as in the event of a claim the cumulative cost of several assets may exceed the excessive.
Disposal of Asset:
Appropriate records must be kept in relation to assets written off the register and evidence of approval signed off by the Head of Department, as recommended by the College’s external Auditors. These records must be available for inspection.

There are three “books”: ACTUAL, INSURANCE and DEPARTMENT, which record assets according to their financial significance to the College.

Actual Book
If you enter an asset whose purchase cost is greater than or equal to €1269.74 and the College owns it, its details are entered into the ACTUAL book. This book records items that are to be capitalised, i.e., included in the College accounts.

Insurance Book
Assets whose purchase costs are greater than or equal to €1269.74 (including those on loan or leased to College and excluding vehicles) are automatically entered into the INSURANCE book.

Department Book
Assets whose purchase costs are less than €1269.74 are entered into the DEPARTMENT book. These do not appear in the College accounts and are recorded here for your convenience.

1.7 Query, Update and Group Users

Each department has two distinct types of users.

- The query user has full access to view the department’s assets, but update privileges are denied.
- The update user has access to the same facilities as the query user, but changes (insert, delete, amend assets) are also allowed.
- The Group user has access to the same facilities as the Update user, but bulk inserts, deletes and amendments are also allowed.

The username and password is the same as your current College logon User ID and password. However permission must be obtained to enter the system. This is gained by contacting the Director of Buildings’ Office.

1.8 Coding of Invoices

To allow for reconciliation between Coda Financials and the Asset Register it is imperative that your equipment invoice is correctly coded when forwarding to the Treasurer’s Office for payment. It is equally important that the full cost of the asset is entered in the register including VAT. No estimates or rounded values should be entered in the register.
1.9 Physical Inventories

It is important that a physical inventory of your departmental assets is carried out from time to time throughout the year and that any location changes are noted. It is particularly important that an inventory is carried out before signing the end of year declaration of accuracy.
2 Asset Register System Login

2.1 Getting Started
From the college HOME PAGE, click on College Services and then on Director of Building’s Office. http://www.tcd.ie/buildings

Click on ‘Asset Register’ from the menu on the left hand side. The Asset Register introduction page appears. This page gives a quick introduction to the asset register and a list of users who have access to the system.
1.9 Physical Inventories

It is important that a physical inventory of your departmental assets is carried out from time to time throughout the year and that any location changes are noted. It is particularly important that an inventory is carried out before signing the end of year declaration of accuracy.
3 Asset Register System Login

3.1 Getting Started

From the college HOME PAGE, click on College Services and then on Director of Building’s Office. http://www.tcd.ie/buildings

Click on ‘Asset Register’ from the menu on the left hand side. The Asset Register introduction page appears. This page gives a quick introduction to the asset register and a list of users who have access to the system.
To enter the system please click on the ‘Click here to login in’ link. A login box appears, prompting you for a username and password.
If you have not logged into the TCD Portal System before you must first register. Click on the ‘Register’ hyperlink and follow the steps outlined. Otherwise, enter your current Windows NT User ID and password. These are case sensitive and must be entered correctly. Once entered, click on the ‘OK’ button. If you entered an erroneous username and password combination, you will be prompted to re-enter. Once entry is gained to the TCD Web Portal the following appears:

![Image of the TCD Asset Register user interface]
4 Asset Register Navigation

4.1 Overview
Throughout the Asset Register System the same icons and link appear and these always have the same functions as follows:

Portal Home: This icon takes the user back to the TCD Web Portal Screen.

Portal Help: This icon produces a pop up window for general TCD portal help.

Log Me Off: This icon logs the user out of the TCD Web Portal.

Menu: Takes the user back to the Asset Register main page.

Page Help: Displays Asset Register Help on each individual page.

At the bottom each page there is an email link “For page support email helpdesk@tcd.ie”. This allows you to e-mail the ISS helpdesk at helpdesk@tcd.ie if an error occurs.
5 **Sub-Department Maintenance**

### 5.1 Overview
Entry to this screen is achieved by clicking on the Sub Department Maintenance hyperlink. The purpose of this screen is to allow display and maintenance of the asset register sub departments.

![Asset Register Screen](image)

#### 5.2 Window Functions
- Each department will always have a ‘ADM sub-department and this can never be deleted.
  - The Edit icon takes the user to the edit screen for the selected entry.
  - The Add icon takes the user to the ‘add new Sub-department’ screen.
The Delete icon displays a pop-up message box confirming whether the user wants to delete the selected Sub-department. 'Cancel' just closes the message box. 'Ok' deletes the Sub-department from the Sub-department list and it automatically reorders to account for this change. The delete Icon is only displayed when there are no entries in the asset register for that sub-department.

5.3 Sub Department Edit

5.3.1 Overview

This screen allows you to edit the selected entry of the previous screen.
5.3.2 Page Controls

- ‘Apply’ saves your changes to the database but doesn’t close the current page.

- ‘Close’ saves your changes to the database, closes the current page and redirects you to the Sub-department maintenance page. The changes you have made will be immediately visible.

- ‘Cancel’ abandons the current page without saving your changes.

5.3.3 Page Fields

- **Sub-Department Name**: This is Sub-department name.

- Mandatory fields are indicated with an asterisk and must be completed before the Sub-department can be created or saved.

5.4 Add New Sub-Department

5.4.1 Overview

This screen is basically the same as the Sub-department Edit screen, the only difference being that the data is not already populated on entry to the screen.
6 Add a New Asset

6.1 Overview
Entry to this screen is achieved by clicking on the Add a New Asset hyperlink. The purpose of this screen is to add a new asset to the Asset Register system for your department.

6.1.1 Page Controls
- ‘Create’ saves your changes to the database redirects you to the asset details page where your inputs can be seen.
- ‘Cancel’ abandons the current page without saving your changes.

6.1.2 Page Fields
Before adding an asset, a brief description of all the properties associated with assets is given. Take the time to familiarise yourself with them, as these are the key elements of the asset register.

- **Asset Name:** The asset name.
- **Comments/Description:** A description of the asset or any relevant comment.
This is not compulsory, but may be used to give extra information about the asset, for instance, who it is used by etc

- **Serial No:** The asset’s serial number. You should find this somewhere on the equipment, possibly at the back. Sometimes manufacturers use S/N to stand for serial number. If you can’t find it ask a colleague.

  **N.B.** If the serial number still can’t be found, please write the Asset code on a sticker and place this on the asset.

- **Asset Type:** The type of asset. It must be one of the following: Computers, Furniture, Misc, Other Equipment, Special Equipment and Vehicles.

- **Acquisition Date:** The date the asset was acquired by the college. If the exact date is not known, an approximate should be given. It must be in the current academic year.

- **Supplier:** The supplier of the asset. The ‘Choose Existing Supplier’ button displays a pop-up window from which the user can select from a list of previously entered suppliers for their department. This method is recommended as it aids searching capabilities if the supplier names are the same as those already entered.

- **Lifetime:** The expected lifetime of the asset. This is for your own documentation purposes and can be different from the value used for depreciation. The lifetime field is for your own documentation purposes. The actual “depreciation lifetime” is fixed by the asset type (a financial convention for consistency across departments). The lifetime of the asset can be left blank as this will automatically be picked up from the asset type, i.e. the depreciation lifetime will be inserted. The following are the defaults:

<table>
<thead>
<tr>
<th>Asset Type</th>
<th>Lifetime</th>
</tr>
</thead>
<tbody>
<tr>
<td>Special Eqp</td>
<td>5 years</td>
</tr>
<tr>
<td>Computer</td>
<td>3 years</td>
</tr>
<tr>
<td>Other Eqp</td>
<td>5 years</td>
</tr>
<tr>
<td>Furniture</td>
<td>10 years</td>
</tr>
<tr>
<td>Vehicles</td>
<td>5 years</td>
</tr>
<tr>
<td>Misc</td>
<td>10 years</td>
</tr>
</tbody>
</table>

- **Purchase Cost:** The initial cost of the asset. This is mandatory. It takes the form of a real number with 2 decimal places, i.e. 1420.34. If you enter an integer, e.g. 1420, it will be converted to 1420.00. Do not enter the ‘€’ sign.

- **Funding:** The method of funding used to finance the purchase of the asset. Please choose the correct funding.

<table>
<thead>
<tr>
<th>Funding</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capital Budget</td>
<td>All Equipment coded 41nnn.CCC.CCCP01 (P02 or P03), i.e. Capital Equipment/ET1 Equipment. These are specifically capital equipment codes where the income is from a HEA capital grant and budgets are set up for each department against code 41030.CCC.CCCP0n (CCC is the departmental cost centre code)</td>
</tr>
<tr>
<td>Recurring Capital</td>
<td>(Same as above) – Ignore this funding.</td>
</tr>
<tr>
<td>Equipment</td>
<td>This equates to Recurrent Equipment Grant for which budgets are against</td>
</tr>
</tbody>
</table>
Grant code 41030.CCC.CCCR01.

Department Non Pay Budget: This covers all equipment bought out of Departmental Non Pay Budget. For academic departments, this covers all equipment coded to 81nnn.CCC.CCCnn (eg 81023.508.50800 : Computer Equipment Purchases - Physics Dept. - Department General). For other departments, the codes are:

- Admin. Depts. Codes 11nnn.8CC.8CCnn
- Service Depts. Codes 91nnn.9CC.9CCnn
- Subsidiary Depts. Codes 71nnn.7CC.7CCnn

N.B. Any equipment purchased from “seed-funding”/Provost’s Development Fund can also be included in this category.

Donation (Fund Raising): Self explanatory

Loan (or Lease) to college: Self explanatory

**Note** – Self-Financing Courses/Activities

- All equipment coded to either Self-Financing Courses (41nnn.CCC.CCCCnn) eg 41023.602.602C01 or to Self Financing Activities (41nnn.CCC.CCCFnn) eg 41023.502.502F01 should be shown as Department Non Pay Budget for funding purposes.

- **Replacement Cost:** This equates to the insurance value of the asset. If this is left blank, the replacement cost is assumed to be the same as the purchase cost. This only applies to assets whose purchase cost is greater than or equal to €1269.74.

- **Ownership:** Indicates whether the college owns the asset or is on loan or lease.

- **Maintenance:** Indicates whether a maintenance contract exists on the asset.

- **Trade-In:** Indicates if a trade-in was used in the purchase of the asset.

- **Old asset code:** The asset code for an old asset used as a trade-in for this asset. The old asset will automatically be disposed if it hasn’t already been done so.

- **Trade in value:** The value of the trade-in.

- **Location:** The building in which the asset is located.

- **Room:** The room in which the asset is located. The ‘Choose Existing Room’ button displays a pop-up window from which the user can select from a list of previously entered rooms for their department. This method is recommended as it aids searching capabilities if the room names are the same as those already entered.
7 Asset Register Search & Maintenance

7.1 Search Window
Entry to this screen is achieved by clicking on the Search & Maintenance hyperlink. The purpose of this screen is for the finding and maintenance of assets for your department within the Asset Register.

![Asset Register Search Window](image)

7.1.1 Window Functions

- The search window has 13 fields from which you can search the Asset Register. Searching itself is done by entering information into one or more fields and pressing the search button. There are two types of field on this window:
  - Free text fields (e.g. Asset Code, Asset Name), where the user simply types in the data. The use of a wildcard % is permitted.
  - Dropdown fields (e.g. Asset Type, Acquisition Date, Funding, Sub-department etc) are also provided to aid searching.

- The reset button will set all fields back to their default state.
7.2 Search Results

7.2.1 Overview
This screen allows you to view all assets from the search criteria entered on the previous screen.

Note: If you still have a long list of assets you can search these assets by using the ‘Find’ functionality of your browser. In internet explorer by going to the Edit menu and selecting the Find menu you get a pop up window that allows you to search the page.

7.3 Asset Details

7.3.1 Overview
This screen allows you to view, edit or dispose the selected entry of the previous screen depending on your system privileges.
7.3.2 Page Controls

- 'Update This Asset' link only appears when the asset is not already disposed. This link takes you to the Update Asset page where amendments can be made to the asset.

- 'Dispose This Asset' link only appears when the asset is not already disposed. This link takes you to the Dispose Asset page where the asset can be disposed.
7.4 Update Asset

7.4.1 Overview

This screen allows you to edit the selected entry of the previous screen.

7.4.2 Page Controls

- ‘Apply’ saves your changes to the database but doesn’t close the current page.
- ‘Close’ saves your changes to the database and closes the current page and redirects you back to the asset details page, any changes just made will be immediately visible.
- ‘Cancel’ abandons the current page without saving your changes.
- ‘Existing Supplier’ button displays a pop-up window from which the user can select from a list of previously entered suppliers for their department. This method is recommended as it aids searching capabilities if the supplier names are the same as those already entered.
- ‘Existing Room’ button displays a pop-up window from which the user can select from a list of previously entered rooms for their department. This method is recommended as it aids searching capabilities if the room names are the same as those already entered.
7.4.3 Page Fields

- **Asset Type**: This is the type of the asset selected. The asset types are Computers, Furniture, Misc, Other Eqp, Special Eqp, and Vehicles. This field can only be modified whenever the Asset Status is ‘New’ or the Asset Book is ‘Department’.

- **Asset Name**: This contains the assets name and can be changed if required.

- **Asset Comments**: Any description or additional comments about the assets can be modified here.

- **Serial No**: The asset’s serial number can be corrected here.

- **Supplier**: The supplier of the asset can be corrected here.

- **Sub-Department**: The sub-department to which the asset belongs to within the department can be modified here.

- **Location**: The building in which the asset is located can be corrected here.

- **Room**: The room in which the asset is located.

- **Lifetime**: The lifetime field is for your own documentation purposes. The actual “depreciation lifetime” is fixed by the asset type (a financial convention for consistency across departments). The lifetime of the asset can be left blank as this will automatically be picked up from the asset type, i.e. the depreciation lifetime will be inserted. The following are the defaults:

<table>
<thead>
<tr>
<th>Asset Type</th>
<th>Lifetime</th>
</tr>
</thead>
<tbody>
<tr>
<td>Special Eqp</td>
<td>5 years</td>
</tr>
<tr>
<td>Computer</td>
<td>3 years</td>
</tr>
<tr>
<td>Other Eqp</td>
<td>5 years</td>
</tr>
<tr>
<td>Furniture</td>
<td>10 years</td>
</tr>
<tr>
<td>Vehicles</td>
<td>5 years</td>
</tr>
<tr>
<td>Misc</td>
<td>10 years</td>
</tr>
</tbody>
</table>

- **Acquisition Date**: This is the date the asset was acquired. This field can only be modified whenever the Asset Status is ‘New’ or the Asset Book is ‘Department’ and its Status is ‘Current’.

- **Purchase Cost**: The asset’s Purchase cost can be modified here. This field can only be modified whenever the Asset Status is ‘New’ or the Asset Book is ‘Department’ and its Status is ‘Current’.

- **Funding**: The funding of the asset can be modified here.

- **Ownership**: Weather the asset is owned by the college or on lend.
• **Insured**: If the Asset is Insured.

• **Maintenance**: 

• **Book Type**: This contains the assets Book type.

• **Book Value**: The asset’s Book value can be modified here

• **Replacement Value for Insurance**: The asset’s insurance value can be modified here. This field can only be modified whenever the Insurance Status is not ‘Disposed’

• **New Book Value**: A New Book Value can be inserted in the Actual or Insurance Book when a entry does not exist in either.

• **Buy Out Date**: This field appears when inserting a New Book Value; it is the date that the Asset’s lease expires therefore the Asset is then owned by the College.

### 7.4.4 Asset Status and Update Options

<table>
<thead>
<tr>
<th>Status</th>
<th>Action/Event which set status</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Set when a new asset is inserted</td>
<td>Acquired this academic year.</td>
</tr>
<tr>
<td>Current</td>
<td>Set if the status is New at the end of the academic year.</td>
<td>Acquired before this academic year and is still in use.</td>
</tr>
<tr>
<td>Disposed</td>
<td>Set when asset is disposed of.</td>
<td>Asset is no longer in use.</td>
</tr>
<tr>
<td>Finished</td>
<td>Set if the status is Disposed at the end of the academic year.</td>
<td>Asset has no more financial significance.</td>
</tr>
</tbody>
</table>

Depending on the status of the asset, different options are displayed when you choose Asset Value Update.

**‘Current’ Status**

If the asset has a status of ‘Current’, i.e., it has been acquired before this academic year and is still in use. As the annual depreciation run has already taken place (the end of the previous academic year), certain properties cannot be altered. Hence, only one option appears – Current Value Change. This equates to the replacement cost and is what the asset is insured for.

**‘New’ Status**

If on the other hand, the status is New, i.e., the asset has been acquired in the current academic year, all values can be changed. This is because no annual depreciation run has taken place yet and updates for the asset type, the current value, the purchase cost and the acquisition date are allowed.
7.5 Dispose of Asset

7.5.1 Overview

This screen is allows you to dispose of an asset. An asset may be disposed of from the Actual or Insurance books (or both). Disposing of an asset from the Actual book means that the College no longer owns it. Disposing of an asset from the Insurance book means that it is no longer insured. Thus, if an asset is not in the Actual Book, but is in the Insurance book, the asset is either on loan or leased to the College but is insured by the College.

7.5.2 Page Controls

- ‘Dispose’ disposes the asset.
- ‘Cancel’ abandons the current page without saving your changes.
7.5.3 Page Fields

**Asset Book**: The book you wish to dispose from.

**Disposal Date**: The date of Disposal. Default to the current date.

**Reason for Disposal**: A reason for the disposal must be given. Four options are given – asset written off, asset returned to lessor, asset sold or other. ‘Other’ covers any other reason.

**Other Comments**: Enter any other Disposal comments in the given field

**Selling Price**: If the asset was sold, a selling price must be entered in numeric form
8 Asset Register Reports

8.1 Overview
Entry to this screen is achieved by clicking on the Asset Reports hyperlink. The purpose of this screen is to produce a report for all assets currently registered for the department in question.

8.2 Report Selection
Assets and Disposals are grouped by the Asset Type, i.e.
- Computers
- Furniture
- Misc
- Other Eqp
- Special Eqp
- Vehicles
8.3 Report Sort and Print

Clicking on the Ascending or Descending arrows beside each column header to sort the report appropriately can do sorting of the report.

It is necessary to print this report in landscape format in order to see all the information on the printed sheet. To do this, select Page Set-up from the File menu on the browser. Then click on the landscape radio button. Alternatively, you can select Properties from the Print option and select landscape from there.

8.3.1 Internet Explorer Printing

For the best printing results Internet Explorer need to be configured for print.

- For A4 paper the web page will print better if the page set up is set to landscape. To do this select ‘Page Set-up’ from the ‘File’ menu and check the ‘Landscape’ option before printing.
• To ensure that background colours are printed select ‘Internet Options’ from the ‘Tools’ menu. Scroll down to The printing menu and check ‘Print background colours and images’ as follows:

8.3.2 Netscape Printing

• Netscape seems to always print coloured table cells either with colors or shading, depending on your printer. But you can separately control whether it will print the page background colour or image.
- Click on the File menu.
- Select Page Setup
- Go to the Page Options section,
- Check Print Backgrounds to include the page background in your printout.

- For A4 paper the web page will print better if the page set up is set to landscape. To do this select:
  - Select File from the menu bar.
  - Select Print from the drop-down menu.
  - Click the Properties button in the dialog box.
  - Select Landscape in the Orientation section.
  - Select OK to save these settings.
  - Select OK to print.
  - Remember to reset the orientation to Portrait if you print other documents.
9 Download Assets to Excel

9.1 Overview
This option is intended to facilitate users who prefer working with Excel. Assets cannot be added or updated in this manner, but it does enable the user to quickly browse through their department’s assets. It is also straightforward to create your own reports. Entry to this screen is achieved by clicking on the Asset Download hyperlink.

9.1.1 Page Fields
1. Click on Download deptasset.csv.

2. You will be prompted to choose between opening the file immediately or saving it to disk. Click the OK button.
3. A Save As dialog box appears. Choose the destination directory and rename the file if required. Click the OK button.

4. Once the file has been created on your hard disk it can be opened up in Excel. Resize the field widths as necessary to view all the details – you can select all the text by pressing CTRL+A and use the AutoFit selection option provided with Excel. In Microsoft® Excel 2000, this can be found under the Format Column menu. Other versions may differ slightly.

**Note**
Although it opens up in Excel, it is still only a comma separated values file. You must change the type to Excel workbook by choosing Save As from the File menu in Excel. Only then, will any formatting changes be saved.
10 Group Maintenance

10.1 Overview

Coming Soon
## APPENDIX A - DOCUMENT AMENDMENT REGISTER

Document: Asset RegisterSystem User Guide.doc

<table>
<thead>
<tr>
<th>Version</th>
<th>Issue Date</th>
<th>Details of Changes</th>
<th>Author</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.1</td>
<td>20/3/2003</td>
<td>First unauthorised draft</td>
<td>Michael Hughes</td>
</tr>
</tbody>
</table>